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VWorks Automation Control 13.1.7
Setup Guide Addendum

For MySQL 8.0.18

This guide contains the following topics:

e “About this addendum” on page 2

e ‘“Installing MySQL" on page 2

e ‘“Installing and setting up a MySQL ODBC" on page 14
e “Connecting to the Inventory database” on page 18



About this addendum

This is an addendum to the VWorks 13 edition of the VWorks Automation Control Setup
Guide (part number G5415-90067). This addendum is applicable if your system meets
both of the following conditions:

e You are running VWorks 13.1.7 on Microsoft Windows 10 64-bit.

e Your system contains a device, such as a Labware MiniHub, that requires a
database for the VWorks labware inventory management feature.

Note: The database may be configured already if the computer was provided by
Agilent.

This addendum describes how to do the following:

e Install MySQL 8.0.18.

e Install and set up a MySQL 8.0.18 ODBC.

e Connect to the Inventory database for either of the following:
- MySQL5.7
- MySQL8.0.18

Installing MySQL

Before you start

Required installation files
Ensure you have the following installation files:

e VC_redist.x64.exe
e VC_redist.x86.exe
e mysgl-installer-community-8.0.18.0.msi
e vworks_mysql_8.0.sq|
This file is installed with the VWorks software in the following location:

C:\\Program Files (x86)\Agilent
Technologies\VWorks\Schema\vworks_mysgl_8.0.sql

For assistance, contact Agilent Technical Support.

Required computer settings
Before you install the software:

e Log on to the computer as an administrator with full rights.

< In Microsoft Windows Explorer, select the following View > Show settings:
—  Select Hidden items.
— Select File name extensions.

For detailed instructions, see the Microsoft Windows user documentation.



Installation and setup workflow

Step  Forthis task...

See...

1 Uninstall any existing MySQL
versions, and then restart the
computer.

“Uninstalling previous versions of
MySQL" on page 3

2 Install MySQL Server 8.0.18

“Installing MySQL 8.0.18" on page 6

3 Install MySQL ODBC and set up
the data sources.

“Installing and setting up a MySQL
ODBC" on page 14

4 Connect to the VWorks database.

VWorks Automation Control Setup
Guide for VWorks 13.

Uninstalling previous versions of MySQL

Before you uninstall:

Make a backup copy of your existing database before uninstalling it. To back up the
Inventory database (velocity11), labware definitions, liquid classes, and pipetting
techniques, see the VWorks Automation Control User Guide.

To uninstall MySQL:

1 Log onto the computer as an administrator.
2 Inthe Microsoft Windows desktop, go to Settings > Apps & features, and uninstall

the following:

a MySQL Server

b MySQL Connector/ODBC
3 Restart the computer.

4 Verify that the MySQL service is completely removed:

a In Microsoft Windows Explorer, right-click the This PC icon. In the shortcut
menu, click Manage. The Computer Management window opens.

b Inthe Computer Management window, click Services and

Applications > Services.

Cc Inthe list of Services, ensure MySQL does not appear:
e If MySQL does not appear, go to step 8.
e |f MySQL appears in the list, continue to step 5.
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5 Inthe list of Services, right-click MySQL and click Stop.

Note: If an error message appears and states that it is unable to stop, ignore the
message.

6 Openthe Command Prompt window, as follows:

a Inthe C:\Windows\System32 folder, right-click cmd.exe, and then select
Run as administrator.

b Click Yes in the User Account Control dialog box that opens.

| = | System32 Manage - o x
Home Share View Application Tools 2]
“ v « Windows » System32 w & | Search System32 R
System32 A Name " Date
{3DA228BE-34DA-4313- A0 B cd.exe
409 cmdet.dll  ~ Open
Advancedinstallers emdial32.dll & Run as administrator
et 1] emdkey.exe Pin to Start
B emdizz.exe & Move to OneDiive
Applocker
1 emgrespps.dil )
appraiser comifondll Scan for Viruses...
AvoV ol B 12 Shore
4,528 items 1item selected 272 KB Pin to taskbar

Cc Execute the following line in the Command Prompt window:
sc delete MySQL <enter>

BE Administrator: C\Windows\System32\cmd.exe - O *

7 Check the registry keys for any references to old versions of MySQL as follows:
a Open the Registry Editor.

b Navigateto
HKEY_LOCAL_MACHINEASOFTWARE\WOW6432Node\MySQL AB\

c |If present, delete MySQL Server 5.1 or MySQL Server 5.0.



Installing MySQL

B Registry Editor - m] 4
File Edit View Favorites Help
Computer\HKEY_LOCAL_MACHINE\SOFTWAREVWOWS432Node

> | Velatile A MName Type Data
v ESOWESRode 28] (Defaut) REG_SZ
Adobe
|| Agilent
. Agilent Technologies
Caphyon
. Cisco
| Classes
Clients
Cofense

. Conexant
| FileZilla 3

FileZilla Client
> || Google

e W W N N N W N

< Lo <| >

8 Restart the computer.

Ensure that you restart the computer after uninstalling th MySQL Server and MySQL
IMPORTANT Connector/ODBC.
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Installing MySQL

Installing MySQL 8.0.18

Before installing MySQL 8.0.18, install the Microsoft Visual C++ redistributable package.

To install the Microsoft Visual C++ redistributable package:
1 Runthe vc_redist.x64.exe file.

2 Follow the Setup Wizard instructions.

3 Runthe vc_redist.x86.exe file.

4  Follow the Setup Wizard instructions.

Note: If the computer already has Microsoft Visual Studio 2017 or Microsoft Visual C++
2017 Redistributable installed, the MySQL installer might not recognize that the

VC 2015 Redistributable is installed even if it is. To fix this issue, go to Settings > Apps.
In the Apps & features window, locate Microsoft Visual C++ 201, right-click, and then
choose Modify. Click Repair when the installer window opens.

To install MySQL 8.0.18:

1 Runthe mysgl-installer-community-8.0.18.0.msi. The MySQL Installer setup wizard
opens.
Note: If Visual Studio 2017 or the Visual C++ 2017 redistributable package is
installed on the computer, the MySQL installer might display an error message
stating that Visual C++ redistributable is not installed even if it is. To fix this, go
to Apps and Features, select Microsoft C++ Redistributable, right-click and then
select Modify. In the Microsoft C++ Redistributable Setup screen, click Repair.

2 Inthe Choosing a Setup Type page, select Custom, and then click Next.

[Z] MysQL Installer - X
AN
MySQL. Installer Choosing a Setup Type

Adding Community

Please select the Setup Type that suits your use case,

Choosing a Setup Type O Developer Default Setup Type Description
Installs all produsts needed for l;.-llc-.us you to select exactly which products you
MySOL development purposes. would like to install. This also allows to pick other|
server versions and architectures (depending on
jour05).
) Server only i

Installs only the MySOL Server
product.

O Client only

Installs only the MySCL Client
products, without a server,

O Full
Installs all included My3CL
products and {eatures.

@ Custom
Manually select the products that
should be installed on the
system.

Net> || Cancel

3 Inthe Select Products and Features page, select the following Available Products and
then click the right arrow to move each selection to Products/Features To Be
Installed:

MySQL Servers > MySQL Server > MySQL Server 8.0 > MySQL Server 8.0.0.1.8- X64
MySQL Connectors > Connector/ODBC > Connector ODBC 8.0.18 -X86
Click Next.
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MySQL Installer

RN
MySQL‘. Installer Select Products and Features
Adding Community

Filter:

Installing MySQL

Please select the products and features you would like te install on this machine.

'?_\ [,"-!I Software,Current Bundle, Any

| Ear

Select Products and Features Available Broducts:

Products/Features To Be Installed:

[ MySQL Servers
| = MySOL Server
| = MySQL Server 5.0

[ Applications

(= hySQL Connectors

| - Connector/ODEC

| = Connector/ODEC 8.0

(- Connector/C++

| [ Connector/)

| - Connector/NET

| [ Connector/Python
[ Dacumentation

249

= MyS0L Server 8.0.15 . X64
| = mysa server

[ client Programs

[FDevelopment Components

~[CJoocumentation
 ~Aserver datafites
B Connector/ODEC 8.0.18 - X86

- [ZIMyscL Connector/ODEC 8.0.18 32

4 In the Installation page:

a Make sure that MySQL Server 8.0.18 and Connector/ODBC 8.0.18 are Ready to

Install, and then click Execute.

< Back | | Mext > Cancel

b When the installation is finished, click Next.

[T MysQL Installer

Adding Community

Installation

The following products will be installed.
Product Status Progress Motes
MySQL Server 8.0.18 Ready to Instal
[2] connectonoec 018 Ready to Instal

VWorks Automation Control 13.1.7 Setup Guide Addendum

Click [Execute] to install the following packages.
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Installing MySQL

5 Inthe Product Configuration page, click Next.

MySQL Installer - X

MySQL. Installer Product Configuration
Adding Community

We'll new walk through 2 configuration wizard for each of the fellewing preducts.

Vou can cancel at any peint if you wish to leave this wizard without configuring 2l the

products.
Product Status
MySGL Server 80,18 Ready to configure
Product Configuration
< >

[ Mext > Cancel ]

6 In the High Availability page, select Standalone MySQL Server / Classic MYSQL
Replication, and then click Next.

MySCL Installer - X

NS
MySQL. Installer High Availability

SOL S . -~
ndalone rver sic plication

MySQL Server 8.0.18 @ Stendal Server / Clas: QL Replicat
Choose this option to run the MySQLinstance as o standalone database server with the
opportunity to configure cassic replication later, With this option, you can provide your own
high-availability solution, if required.
High Availability
) InncDB Cluster

The InnaDB duster technology provides an out.ofthe.bax high availability (H&) solution far

MyS0L using Group Replication.

; s

3 - N
TS — R —
.

InnoDB Cluster

Note: InnoDB cluster requires a minimum of three MySQL server instances to provide a
fully automated HA sclution. Members of a cluster should be located such that network
communication latency between servers is low.

Next > |_ Cancel
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Installing MySQL

7 Inthe Type and Networking page, specify the following:
* Config Type > Development Computer
e TCIP/IP > Open Windows Firewall ports for network access
e Show Advanced and Logging Options
Click Next.

MySQL Installer - ®

MySQL. Installer Type and Networking

MySQL Server 8.0.18 Server Configuration Type

Choose the correct server configuration type for this MySQL Server installation. This setting will
define how much system resources are assigned to the MySQL Server instance.

Config Type: | Development Computer v |

Connectivity
Use the following controls to select how you weuld like to connect to this server.
& Tepp Port X Protocol Port
[#] Open Windows Firewall ports for network access
[ Mamed Pipe Pipe Neme:  MYSOL

[ Shared Memary Memory Name:  MYSOL

Advanced Configuration

Select the check box below to get additional configuration pages where you can set advanced
and legging options for this server instance.

[A[Shew Advanced 2nd Legging Opticns,

I < Back || Mest > H Cancel

8 Inthe Authentication Method page, select Use Legacy Authentication Method (Retain
MySQL 5.x Compatibility).

Click Next.

MySQOL Installer - x

MySQL. Installer Authentication Method

MySQL Server 8.0.1
AL ¥ (O Use Strong Passwerd Encryption for Authentication (RECOMMENDED)

MySQL £ supports 2 new authentication based on improved stronger SHAZ58-based password
methods. It is recommended that 2/l new MySCQL Server installations use this methed geing
forward.

Attention: This new authentication plugin on the server side requires new versions
& of cannecteors and clients which add suppert for this new 8.0 default authentication
(caching_sha2_password authentication).
Authentication Method
Currently MySQL 8.0 Connectors and community drivers which use libmysqlclient 8.0 support
this new method. If clients and applications cannet be updated to support this new
authentication method, the MySQL 8.0 Server can be configured to use the legacy MySQL
Authentication Method below.

®) Use Legacy Authentication Method (Retain MySQL 5. Compatibility)
Using the ald MySQL 5x legacy authentication method should only be considered in the
following cases:

- If applications cannet be updated to use MySOL B enabled Connectors and drivers.
- For cases where re-compilation of an existing application is not feasible.
- An updated, language specific connector or driver is not yet available.

Security Guidance: When possible, we highly recommend taking needed steps towards
upgrading your applications, libraries, and database senvers to the new stronger authentication.
This new method will significantly improve your security,

I < Back ‘ ‘ Next > Cancel
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Installing MySQL

9 Inthe Accounts and Roles page, type agi | ent for MySQL Root Password and

Repeat Password fields.
Click Next.

MySCL Installer _ %
5
MySQLﬁ Installer Accounts and Roles
MySQL Server 80.18 Reot Account Password
f:;(e;lthe password for the root account, Please remember to store this password in 2 secure

MySCQL Root Password: |nu“c |

Repeat Password: [sesesed |

Password strength: Weak

Accounts and Roles

MySQL User Accounts

Create MySQL user accounts for your users and applications. Assign a role to the user that
consists of a set of privileges.

MySOL User Name Hest User Role | Add User |

| Ed

I < Back || DNext > |[ Cancel

10 In the Windows Service page, specify the following:
e Configure MySQL Server as a Windows Service
e Make sure you specify the following:
—  Windows Service Name > My SQL
—  Start the MySQL server at System Startup
— Run Windows Service as > Standard System Account
Click Next.

MySOL Installer - %

AN
MySQL. Installer Windows Service
MySQL Server 8.0.18 B4 Cenfigure MySQL Server as a Windows Service
Windows Service Details

Please specify a Windows Service name to be used for this MySQL Server instance.
A unique name is required for each instance,

Windaws Service Name: |M_|’5QL|
[ Start the MySQL Senver at System Startup

Windows Service Run Windows Service as ..
The MySQL Server needs to run under a given user account, Based on the security
requirements of your system you need to pick one of the options below.

(® Standard System Account
Recommended for most scenarios.
() Custom User

An existing user account can be selected for advanced scenarios.

< Back || et > || Cancel
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Installing MySQL

11 In the Logging Options page, accept the default settings. Click Next.
Note: The file paths are based on the computer name.

MySQL Installer - 'Y

MySQL. Installer Logging Options

MySQL Server 8.0.18 Please select the logs you want to activate for this server in addition to the erorlog.

On production computers, it can be beneficial to separate the log files from the data.
Specify a file name to save the legs in the data directory (default) or browse to a

different location.

You must provide an absclute path when specifying the path together with the file name.

EmorLog: [DESKTOP-EGMIPG3 e |~ [2]

[ General Leg

The general query log is a general record of what the MySCL Server is doing.
It sheuld enly be used to track down issues.

FilePath:  DESKTOP-ESM1PE3log « [H

Logging Options FA Slow Query Leg

The slow query log consists of SQL statements that took more than the given value of
seconds to execute. It is recommended to turn this log on.

File Path: | DESKTOP-EBMIPG3-slowlog | =[] seconas:

[ ginLeg

The binary log contains all database events and is used for replication and data recovery
cperations. Enabling the log has a performance impact on the server.
Enter the log name without 3 file extension,

FilePath: [DESKTOP-E8M1P63-bin | [

I < Back || Next > H Cancel

12 In the Advanced Options page, accept the default settings. Click Next.

MySQL Installer — "

MySQLi Installer Advanced Options
MySQL Server 8.0.18

s

A unique numeric identifier used in a replication topology.
If binary logging is enabled, a Server 1B must be specified.

Table Names Case:

® Lower Case (default):

This option sets the configuration variable lower_case_table_names = 1.
(O Preserve Given Case:

This option sets the cenfiguration variable lower_case_table_names = 2.

I < Back |m[ Cancel

13 In the Apply Configuration page, click Execute.
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Installing MySQL

MySQL Installer - b4

MySQL. Installer Apply Configuration
MySQL Server 8.0.18 The following configuration steps are being executed.
Configuration Steps Log
& Witing configuraticn file
Updating Windows Firewall rules
Adjusting Windows service
Initializing database (may take 2 leng time) ..
Starting the server
Applying security settings
Updating the Start menu link

OO0 0®a@a@

Apply Configuration

14 When the screen displays the configuration was successful text, click Finish.
[Z] MysaL Instalter - x

MySQL. Installer Apply Configuration
MySQL Server 80.18 The configurati ion has

[ Configuration Steps | Log

& Writing configuraticn file

Updating Windows Firewall rules
Adjusting Windows service

Initizlizing database (may take a long time)
‘Starting the server

Applying security settings

Qe @8 Q@

Updating the Start menu link

The configuration for MySQL Server 8.0.18 was successful,
Click Finish to continue.

Frish |

12 VWorks Automation Control 13.1.7 Setup Guide Addendum



Installing MySQL

15 In the Product Configuration page, click Next.

MySQL Installer

o

MySQL. Installer Product Configuration
Adding Community

We'll now walk throwgh a configuration wizard for each of the fellowing products.

Vou can cancel at any paint if you wish to leave this wizard without configuring all the

preducts.
Froduct Status
MySCL Server 8018 Configuration complate,

Product Configuration

Next » Cancel ]

16 Click Finish in the Installation Complete page.

VWorks Automation Control 13.1.7 Setup Guide Addendum
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Installing and setting up a MySQL ODBC

About this topic
This topic describes how to install and set up a data source in MySQL ODBC (open
database connectivity) for the VWorks Inventory Editor.
During the MySQL ODBC connection setup you will:

e Import the VWorks database schema into MySQL. This sets up the database table
structure for use by the VWorks Inventory Editor.

e Create, define, and configure new ODBC data source so that MySQL can access
data in the database.

Importing the database schema

To import the database schema:
1 Copy the following database schema file:
vworks_mysql_8.0.sg

Note: This file is installed with the VWorks software in the folder:
C:\\Program Files (x86)\Agilent Technologies\VWorks\Schema\

Paste the copy into the following folder:
C:\\Program Files\MySQL\MySQL Server 8.0\bin\

(e = | bin - O X
Home Share View 0
<« v 4 <« Program Files » MySOL » MySQOL Server 8.0 » bin v O Search bin o
MySQL ~ Mame - Date modified “
MySQL Server 8.0 [] mysqlimport.exe 9/20/2019 8:23 AM

bin [] mysqlpump.exe

docs [ mysqlrouter.exe

etc %] mysglrouter_http.dIl
include [ mysqlrouter_keyring.exe

[] mysqlrouter_passwd.exe
lib
: [E] mysqlrouter_plugin_info.exe

share [®] mysqlshow.exe

NVIDIA Corporation [ mysqlslap.exe
Realtek [ perror.exe
Reference Assemblies || vworks_mysql_8.0.5ql

Uninstall Information [ zlib_decompress.exe

AMitems  1item selected 7.59 KB

2 Opena Command Prompt window, as follows:

a Inthe C:\Windows\System32 folder, right-click cmd.exe, and then select
Run as administrator.

b Click Yes in the User Account Control dialog box that opens.

14



v | System32 Manage - [m] x)

Home  Share View Application Tools (7]

L « Windows > System3l v O ear o
System32 A Name A
{3DA228BE- J4DA-40f4- Al BN cmd.exe
4 ded.dl -
0409 o ~.  Open
Advancedinstallers omdial3z. % Run as administrator
am-et [ cmdkey.exe Pin to Start
Gl emdiz2.exe @ Move to OneDrive
AppLocker
emgrespps.dil .
appraiser —— Scan for Viruses...
MooV v < & Share
4,528 items 1 item selected 272 KB Pin to taskbar

3 Execute the following lines in the Command Prompt window:
cd c:\programfiles\mysqgl\nysql server 8.0\bin <enter>
mysqgl -u root -p < vworks_nysql _8.0.sqgl <enter>

BN Administrator: C\Windows\System32\cmd.exe - mysql -u root -p —

Mi tu [ n

When prompted for password, enter agi | ent .
Make sure no errors occur while executing this command.

Creating ODBC connections

To create ODBC connections:

1 Open the ODBC Data Source Administrator to create ODBC connections, as
follows:

In the C:\Windows\SysWOW&64 folder, right-click odbcad32.exe, and then select
Run as administrator. The ODBC Data Source Administrator (64-bit) dialog box

opens.

(e = | SysWowe4 - m} x
“ Home Share View 0
- v P » ThisPC » Local Disk (C:) » Windows 5 SysWOWed » v D Search SysWOW6B4 pe

v SysWOW64 " Name
0409 )| occachedll
Advancedinstallers | ocsetapi.dlil
Applocker )| odbc32.dll
—
ar-54 i) odbcad32.exe
dbchep.dil
bg-BG | odbcbep
| odbcconf.dil
Eth
props =] odbcconf.exe
catroot | odbeconf.rsp
CCM )| odbcep32.dil
com | odbcer32.dll
config )| odbccu32.dil
Configuration | odbcint.dll
— v €
2,876 items

15
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2

3

In the ODBC Data Source Administrator dialog box:
a Remove any previously defined MySQL ODBC Driver Sources as follows:

e Click the User DSN tab, select any predefined MySQL ODBC Driver
Sources named velocity11, and click Remove.

e Click the System DSN tab, select any predefined MySQL ODBC Driver
Sources named velocity11, and click Remove.

In the System DSN tab, click Add to create a new data source.

C¢ Inthe Create New Data Source dialog box, select MySQL ODBC 8.0 ANSI Driver,
and then click Finish.

= ODBC Data Source Administrator (32-bit) ®
User DSN  System DSN  Fle DSN  Drivers  Tracing  Connection Paoing  About
Systern Data Sources:
Name Platforn  Driver Add..
Remove
Create New Data Source X

Select a driver for which you want to set up a data source

5 Name VA
Microsoft Paradox Driver ("db ) 1
A ODEC System data source stores rformation about h ik, Microsoft Paradox-Treiber (*.db } 1
| ASystem data source is vishle to all users on this machir Microsoft Text Driver ("td; *.csv) 1
T Microsoft Text-Treiber (“txt; “.csv) 1
MySQL ODBC 8.0 ANS| Driver 8
MySQL ODBC 8.0 Unicode Driver 8

S0OL Server 1 5
€ >

< Back Cancel

In the MySQL Connector/ODBC Data Source Configuration dialog box that opens,
define your data source as follows:

Note: You do not have to provide a port number. Use the default number
displayed.

Settings for VWorks Inventory database

Connection Parameters Settings

Data Source Name VWorksInventory

Description (optional) VWorkslInventory database
TCP/IP Server localhost

User vworks

Password vworks

Database velocity11

a Click Details to expand the dialog box.
In the Connection tab, select the Enable automatic reconnect check box.

¢ Inthe Cursors/Results tab, select the Return matched rows instead of affected
rows check box.



4 Click Test. When the Connection Successful message appears, click OK.

MySQOL Connector/ODBC Data Source Configuration X
AN -
MySOL” D=y

Connector/ODBC

Connection Parameters

Data Source Mame: | VWorksInventory |

Description: | (optional) Vworks Inventory database |

(@) TCP/IP Server: |Iocalhcst | Port: |3306 |
() Mamed Fipe:
Database: Test

Connection  Metadata Cursors/Results Debug 5SL Misc

[ allow big result sets [ can Handle Expired Password

[Juse compression [Enable Cleartext Authentication
[“]Enable automatic reconnect ] Get Server Public Key

[Joon't prompt when connecting

[ allgw multiple statements

[interactive Client

Character Set:
Tnitial Statement: |:|
Plugin Directory: l:l

Authentication l:l

[ o |

Details << I Cancel Help

WySQL Connector/ODBC Data Source Configuration

IS

AN
MysoL:

Connector/ODBC

Connection Parameters

Data Source Mame: | ViWorksInventory

Description: | (optional) VWorks Inventory database

@ TCP/IP Server: |\ocalhost | Port: |3306 |
() Named Pipe:

Database: |ve|odty'11 v| E Test i

Test Result

Connection Metadata Cursors/Results  Debug
[[]Enable dynamic cursars
[ pisable driver-pravided cursor suppart

[[] on't cache results of forward-only cursars

[(JFarce use of forward-only cursars

[ erefetch from server by rows at a time

Return matched rows instead of affected rows
[CJEnable SQL_AUTO_IS_NULL

[1rad CHAR to full length with space

[ Return SQL_NULL_DATA for zero date

Details << OK Cancel

Connection Successful

Help

5 Inthe System DSN tab, verify that the data source appears.

E ODBC Data Source Administrator (32-bit)

Sydtemn Data Sources:

*

User DSM - System DSM Fle DSN  Drivers  Tracing Connection Pooling  About

Name Flatform  Driver
MR 326t MySQLODBC 8.0 ANSI Driver

[ Remave
Configure

OK

An QDB System data source stores information about how to conneet to the indicated data provider,
A System data source is visble 1o all users of this computer, includng NT senvices.

Loty

Click OK to close the dialog box.

For instructions on how to connect to the database in the VWorks software, see the
VWorks Automation Control Setup Guide for VWorks 13.
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Connecting to the Inventory database

18

Before you start

Procedure

Before you can connect to the database, you must install and configure the inventory
database. To install and configure the inventory database, see the appropriate
instructions:

e ForMySQL 8.0.18, see “Installing MySQL" on page 2 and “Installing and setting up a
MySQL ODBC” on page 14.

e For MySQL 5.7, see the VWorks 13 edition of the V\Works Automation Control Setup
Guide (part number G5415-90067).

To connect to the Inventory database:

1 Inthe VWorks window, click Tools > Options.

2 Inthe Options dialog box under DB Setup, verify the following, and then click OK.
Note: For MySQL 5.7, no entry is required for DBUser or DBPassword.

DB Setup parameters MySQL 8.0.18 MySQL 5.7
Enable database connection Selected Selected
Connection string dsn=VWorkslnventory; dsn=velocity1T,
DBUser vwor ks
DBPassword vwor ks
. Options ? *
1158 A
e £
B DB Setup ]
Enable database connection: r
Connection string: dsn=VWerkslnventory
DBUser: wworks
DBPassword: i
B Error Handling
Halt on low disk space: I
Scheduler error behavior: Processes as many plates as possible
Deadlock behavior: Show the Systern State Editor
Launch pregram if errer eccurs: I J
Enable database connection:
0K Cancel




In This Book

This addendum to the VWorks Setup Guide
describes how to install and configure
MySQL 8.0.18 for VWorks 13.1.7.
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